Contents

Introduction ........................................................................................................................................... 1
Typing the Occasional Non-Standard Character ................................................................. 1
  The Special Characters Tab ........................................................................................................ 3
Using Key Combinations to Type Accented Letters ........................................................... 3
Using the Keystrokes Method ..................................................................................................... 4
  The Character Map ..................................................................................................................... 4
Shortcut Keys .................................................................................................................................. 5
  Removing and Resetting Shortcuts ............................................................................................ 6
Using AutoCorrect for Special Characters .............................................................................. 6
Alternative Keyboards .................................................................................................................. 7
  Installing Another Keyboard ....................................................................................................... 7
  Using Another Keyboard Layout ............................................................................................... 8
  AltGr Combination Keys and the Euro Symbol ......................................................................... 8

Introduction

The need to include non-standard characters in documents is increasingly common these days. Even when writing in English, the names of foreign places and people may require an accented letter, while scientific papers frequently include Greek letters and mathematical symbols. Text may also include things like fractions (a half or a third), degree signs and copyright symbols. This document explains how to type such characters into your text.

Microsoft Word provides several methods for typing special characters. The one you choose depends to a large extent on how many and how frequently you need to type them. Having to type the odd character is one thing; having to type in a foreign language is another.

On the IT Services lab PCs, additional keyboards have been installed in the system for foreign language support. These can be used in any application, not just Word. Details of how to use them are given at the end of this document.

Typing the Occasional Non-Standard Character

To type the occasional foreign character or symbol, it’s easiest to use the Insert Symbol command:
1. Starting with a new or open document, move the Insertion Point to where you want to insert the character then move to the Insert tab and click on the [Symbol] button in the group on the far right.

A selection of recently-used symbols appears, from which you can choose a symbol if the one you require happens to be displayed. To see the full set of symbols:

2. Choose More Symbols... from the bottom of the list - the Symbol dialog box appears:

Currently, the characters shown are those from the (normal text) font (currently Calibri), but you can select symbols from any font. Indeed, some fonts such as Wingdings don't have alphanumeric characters at all but instead show icons (pictures) of various common objects (like a hand or phone).

Below these is the line of Recently used symbols, which mirror those shown when you clicked on the [Symbol] button. To insert a character into your text:

3. Scroll up or down to find the required character then select it and press <Enter> for [Insert]

The Symbol window remains open for you to add further characters to your text, if you need to. Note also that you can at any time click on your text (to activate your document) and continue typing - try it now, if you like.

An alternative method of inserting a character is to double click on it. Try this next:

4. Decide which character in the Symbol window you want to insert then double click on it.

There's no need to explore all the different fonts available, but it is worth looking at Wingdings and Symbol:

5. Click on the list arrow attached to the Font: box then, using the scroll bar, move down the list of fonts and choose Wingdings (an easy way to get to this is to type Wi and then choose Wingdings from the list)

6. Explore the icons provided, inserting some into your text

7. Next, repeat steps 5 and 6 using the Symbol font (type Sy and then choose Symbol)

8. Scroll down and insert the Greek letter alpha (α) - you will need this in a minute

Most of the characters provided in the Symbol font are also available in the font being used for your text and it is better to use these to maintain consistency throughout the document.

9. Repeat step 5, this time moving up to the top of the list of available fonts - type ( (normal text) - this represents the font currently being used in your document (here, Calibri)
Note the Subset: box on the right. This allows you to move directly to a pre-defined subset of characters.

11. Click on the list arrow attached to the Subset: box and explore the subsets provided

12. Select Greek and Coptic

13. Insert an alpha (α) - note the slight difference between this and the one from the Symbol font

**Note:** The Greek letters provided here include some which are not available in the Symbol font. Some have accents and are used for typing modern Greek. Ancient Greek had many other accents; to type these, a specialist font would be required.

**The Special Characters Tab**

There is a second tab labelled Special Characters provided in the Symbol window:

1. Click on the Special Characters tab and note what’s available – eg optional hyphen, copyright, trademark

**Tip:** Make use of the Nonbreaking Space and Hyphen characters when words must not split over two lines.

2. Close the Symbol dialog box by pressing <Esc> or clicking on [Close]

**Using Key Combinations to Type Accented Letters**

Having to select individual characters via the Symbol window is very slow. To speed up typing, Word provides pre-defined key combinations for several characters - for accented letters, in particular. Essentially, you first type the accent using a <Ctrl> key combination and then follow this with the required letter. The table below summarizes some of what's available:

<table>
<thead>
<tr>
<th>Accent</th>
<th>Control Key</th>
<th>Following Letters</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>acute</td>
<td>&lt;Ctrl ' &gt;</td>
<td>a, e, i, o, u, y (and d)</td>
<td>é (and ð)</td>
</tr>
<tr>
<td>cedilla</td>
<td>&lt;Ctrl , &gt;</td>
<td>c</td>
<td>ç</td>
</tr>
<tr>
<td>circumflex</td>
<td>&lt;Ctrl ^ &gt;</td>
<td>a, e, i, o, u</td>
<td>ê</td>
</tr>
<tr>
<td>grave</td>
<td>&lt;Ctrl ` &gt;</td>
<td>a, e, i, o, u</td>
<td>è</td>
</tr>
<tr>
<td>tilde</td>
<td>&lt;Ctrl ~ &gt;</td>
<td>a, n, o</td>
<td>ñ</td>
</tr>
<tr>
<td>umlaut</td>
<td>&lt;Ctrl : &gt;</td>
<td>a, e, i, o, u, y</td>
<td>ë</td>
</tr>
</tbody>
</table>

The above also work with capital letters. Note that for some symbols both the <Ctrl> and <Shift> keys have to be pressed - eg an umlaut is obtained by <Ctrl Shift ;>.

Other key combinations are <Ctrl @> followed by an a for å; <Ctrl &> followed by an a, o or s for æ, ø or ß; and <Ctrl /> followed by an o for ø. Further characters can be obtained using <Ctrl Alt> or <AltGr> and a normal key but these vary according to the keyboard being used and are dealt with later under the section AltGr Combination Keys.

Try typing some accented letters:

1. Hold down the <Ctrl> key and type a comma (,)

2. Release <Ctrl> and type the letter c

A ç should have appeared on the screen - if not, try again.

3. Next try <Ctrl > (the apostrophe is between <L> and <Enter>) followed by e for é

4. The grave accent is the very top left key (above <Tab>) - try <Ctrl ` > followed by e for è

5. Follow this with <Ctrl Shift ;> followed by o for ð

6. Practice with other control key sequences, as detailed above, if you like
Using the Keystrokes Method

Any letter in the standard character set (the computer’s internal alphabet) can be typed in via the numeric keypad while the \texttt{<Alt>} key is also depressed. Though this can be very tedious (and is largely unnecessary in Word) it is still useful to know as it is the simplest method of obtaining certain characters in software which doesn’t have access to \texttt{Insert...Symbol}.

1. Make sure \texttt{Num Lock} is on - press the \texttt{<Num Lock>} key if necessary
2. Hold down \texttt{<Alt>} and, on the \texttt{numeric keypad}, type \texttt{065}
3. Release the \texttt{<Alt>} key - the letter A should appear
4. Repeat steps 2 and 3, this time typing \texttt{<Alt 066>} - for a B
5. Continue with \texttt{<Alt 067>} etc, if you like

The above exercise isn’t really of much use as it’s easier to type in the letters directly using the keyboard. Not all characters are on the keyboard, however, so try out the following:

6. Type in \texttt{<Alt 0176>} for a degree sign (°) - remember to release \texttt{<Alt>}
7. Try \texttt{<Alt 0188>} to \texttt{<Alt 0190>} for fractions ($\frac{1}{4}$, $\frac{1}{2}$ and $\frac{3}{4}$)
8. Try \texttt{<Alt 0232>} and \texttt{<Alt 0233>} for è and é

Remembering the number of each character in the set is almost impossible - most people make a note of one or two of particular interest. You can find out the number, if you need to, by checking the \texttt{Character code} in the \texttt{Symbol} dialog box when \texttt{from:} is set to \texttt{ASCII (decimal)}.

The Character Map

Only a limited number of characters can be typed in using Alt Keystrokes. For those that can’t, the \texttt{Character Map} has to be used. To view this:

1. Click on the Windows \texttt{[Start]} menu button on the \texttt{Task Bar}
2. Choose \texttt{All Programs} then \texttt{Accessories} followed by \texttt{Systems Tools} and \texttt{Character Map}

The following dialog box will appear:

Characters can be moved from the Map via the \texttt{Characters to copy:} box. You use the \texttt{list arrow} attached to the \texttt{Font:} box to set the font required. Then, as with \texttt{Insert...Symbol}, you select characters by \texttt{double clicking} on them or clicking once and pressing \texttt{<Enter>} (for \texttt{[Select]}). Once you have all the characters you need, you click on \texttt{[Copy]} then switch to your program and \texttt{[Paste]}. 
3. Change the font to **Calibri** in the **Font:** box

4. Place one or more characters into the **Characters to copy:** box then [Copy] the characters to the **Clipboard**

5. Move back to your Word document and press <Ctrl v> to [Paste] in the characters

Note that the Character Map will remain open, running as an independent task, until you close it. This can be very useful with programs where *Insert...Symbol* is not available.

### Shortcut Keys

Both the **Control Key Combinations** and **Alt Keystrokes** are **Shortcut Keys** provided for you by Word. For each character, the simplest shortcut key is displayed in the **Symbol** window. However, many of these are complex and Word provides a mechanism for creating your own shortcut key combinations:

1. On the **Insert** tab, click on the [Symbol] button and choose **More Symbols...**
2. Select the **Font:** you require – here, leave it as *(normal text)*
3. Change the **Subset:** to **Latin-1 Supplement** then click on some characters and note any **Shortcut key:**

You will find some shortcuts appear as **Alt+0nnn**, others as **Ctrl+Alt+letter** or **Ctrl+accent, letter**. To the left of any existing shortcut is the **[Shortcut Key...]** button. You use this to define your own shortcuts:

4. Select α from the **Recently used symbols:** (note the current shortcut - **03B1, Alt+x** – try this out, if you like)
5. Click on the **[Shortcut Key...]** button – a dialog box appears, asking you to **Press new shortcut key:**

6. Hold down **<Alt>** and type **a** - note that this key combination is currently **unassigned**

**Note:** If the key combination is already assigned then you can choose to reassign it or use a different combination. You can use **<Alt>, <Ctrl>** and/or **<Shift>** to create shortcuts.

7. Next, decide whether you want to **Save changes in:** **Normal.dotm** (the shortcut will then be available for all documents) or **Document_name** (this document only)
8. Finally, click on the **[Assign]** button then press **<Esc>** to **[Close]** the **Customize Keyboard** window

The new shortcut should now be available - to test it out:

9. Click on your document, leaving the **Symbol** window open but inactive
10. Press **<Alt a>** a few times and watch the αs appear

You can setup shortcuts involving more than one key press - like those already setup for accented letters. For typing Modern Greek, for example, you might want to have an accented α (α):

11. Using the **Subset** button, choose **Greek and Coptic** then select á and click on **[Shortcut Key...]**
12. Press **<Alt >** then release **<Alt>** and type **a**
13. Click on the **Assign** button then press `<Esc>` to **Close** the Customize Keyboard window.

14. Click on your document and test out `<Alt>` followed by a.

Now set up another shortcut, this time redefining an existing one:

15. Move up and select è (after ç) in the **Symbol** window then click on [Shortcut Key...].

16. The current shortcut (under **Current keys**:) is Ctrl+`.E - press `<Alt e>` to create a new one.

17. Repeat step 13.

Note that the right-hand `<Alt>` (<AltGr>) offers you yet another set of possible shortcut keys. In fact `<AltGr e>` is already defined by Word as another shortcut for è:

18. Test out both `<Alt e>` and `<AltGr e>` in your text.

### Removing and Resetting Shortcuts

Removing a shortcut is also done via the **Symbol** dialog box; however, resetting everything to the original default values must be done via the **Tools** menu. To remove a shortcut:

1. In the **Symbol...** window, select the character whose shortcut is to be removed (eg è)
2. Click on [Shortcut Key... then set **Save changes in**: if necessary
3. Under **Current keys**: click on the shortcut you wish to remove - eg Alt+È
4. Click on [Remove] (or just press <Enter>) then [Close] the Customize Keyboard window
5. Repeat steps 1 to 4 for any other shortcuts you wish to remove.
6. Finally, press `<Esc>` to **Close** the **Symbol** dialog box.

If you want to reset everything to the original default values:

1. Click on the [Office Button] then on [Word Options] and move to the **Customize** options.
2. Click on the [Customize...] button at the foot of the Customize window.
3. Set **Save changes in**: to the document/template containing the shortcuts to be restored.
4. Scroll down the **Categories** at the top and select **Common Symbols**.
5. Click on [Reset All...] - when the dialog box below appears, click on [Yes] to reset the keyboard defaults.
6. Finally, press `<Esc>` twice to **Close** both the Customize Keyboard and Word Options dialog boxes.
7. Try pressing `<Alt e>` and `<Alt a>` to see whether they still work - you should find they have reverted to their normal functions (opening the Edit and Table menu as in Word 2003, respectively).

### Using AutoCorrect for Special Characters

Another way of obtaining special characters is through AutoCorrect. This is the facility which automatically corrects spelling mistakes like adn to and. It can be used to convert one sequence of characters into another, including characters not available on the keyboard. Indeed, Word already has some pre-defined entries for the copyright symbol ©, trademark ("™") and registered (®) signs:

1. Try out the character sequences (c) (tm) and (r) - press <Enter>.
2. Next try out 1/2 (for ½) and 1/4 (for ¼) - these must be preceded and followed by a space.

To define your own autocorrect sequence for a particular character:

3. On the **Insert** tab, click on the [Symbol] button and choose **More Symbols...**.
4. Choose the required symbol - eg ⅓ - the first character in the **Subset: Number Forms**.
5. Click on [AutoCorrect...] and the following screen appears

6. Type the characters 1/3 into the Replace: box then press <Enter> to [Add] it and again for [OK]
7. Leaving the Symbol window open, click on your text and try out the new sequence

Though the character ⅓ appears correctly, it only does so when surrounded by a space - ie you can't directly type 2⅓. This is true of most AutoText sequences; you wouldn't want madness to become mandess! However, as you have already seen, an exception occurs where a character is surrounded by brackets - (c) becomes © whenever it is typed, even in the middle of a word.

In fact, AutoCorrect is activated whenever a word is surrounded by matching punctuation characters. These can be brackets or, more commonly, just spaces. When setting up your own shortcuts, you can choose whichever delimiters you want for a particular character:

8. Click on [AutoCorrect...] in the Symbol window to redefine ⅓ a second time
9. Now type .1/3. into the Replace: box then press <Enter> for [Add]
10. Press <Esc> to [Close] both the AutoCorrect and Symbol windows
11. Try the new sequence .2.1/3. - note how it works immediately, even after another figure

Note: To delete a shortcut, type the shortcut characters into the Replace: box then [Delete] the entry.

**Alternative Keyboards**

If you have to type a document in a foreign language then it's best to use a non-English keyboard. On the IT Services lab PCs, these have already been set up for Chinese, French, German, Greek, Italian, Japanese and Spanish. Users don't have the necessary permissions to install any others.

**Installing Another Keyboard**

To install a new keyboard layout proceed as follows:

1. **Right click** on the language indicator button (shown as [EN]) on the right of the Task Bar
2. Choose Settings... - the Text Services and Input Languages dialog box appears
3. Under [Key Settings...] you can set up your own key combinations to switch between keyboards (<Alt Shift> is set as the default, but you can change this too)
4. Click on the [Add...] button then select the required Input language from the list - click on [OK] to add it
5. Click on [OK] twice to close the Text Services and Input Language Options windows.

Removing a keyboard from the system is done in exactly the same way except at step 4 you select the unwanted keyboard and then click on [Remove].

**Note:** When installing a foreign keyboard which utilises a different character set (such as Arabic, Chinese or Cyrillic), you would also need to install a matching font.

### Using Another Keyboard Layout

In this next exercise you will be switching from one keyboard layout to another - typing first in English, then in Greek. Here, the effect is dramatic as a different character set results. The other European language keyboards on ITS PCs use the International keyboard layout, which means that they will load up and print out properly on a PC in these other countries. If you need to type something which will be used abroad, then you would switch to the appropriate keyboard before you start typing.

1. Start typing some text in English (ie using the normal keyboard and Latin characters)
2. Press `<Alt Shift>` until you see Greek appear on the Status Bar - alternatively, click on the [EN] button on the right of the Task Bar and choose EL Greek
3. Type in some more text - this time it appears in Greek characters
4. Repeat step 2, this time returning to English (U.K.)
5. Type some more text to make sure you have reset the keyboard correctly

You can try out the other keyboard layouts provided on the lab PCs, if you like. You'll find Word even checks the spelling for the appropriate language. Ideally you need the matching keyboard as some characters will have moved keys. A touch typist used to the different layout wouldn't be bothered by this. For example, on a German keyboard, the " key and @ key are switched round. Also, if you type `<Ctrl` e you get é not è!

**Note:** For Chinese and Japanese, you have to use a simulated (soft) keyboard.

### AltGr Combination Keys and the Euro Symbol

Most modern keyboards show more than one character on some keys. For example, the number 4 key also has a Euro symbol (€), while the `<>` key also has the ¦ symbol. To type either of these you must make use of the `<AltGr>` key (to the right of the spacebar).

1. Check you are using the English keyboard then hold down the `<AltGr>` key and type 4

   `<AltGr>` is by default set to be equivalent to `<Ctrl Alt>` and you could type a Euro symbol using `<Ctrl Alt 4>` - try it if you like. However, Word can distinguish between `<Ctrl Alt>` and `<AltGr>` - for example `<Ctrl Alt e>` also gives you € while `<AltGr e>` gives you ë. Note that `<AltGr>` key combinations may have different effects on different keyboard layouts.

   **Warning:** Several `<Ctrl Alt>` key combinations invoke system commands and using them (or `<AltGr>`) can give unexpected results. The best advice is to avoid using them unless you know what you are doing (like typing a Euro symbol).

2. End by closing down Word – there’s No need to save the document (or the changes to the global template - unless you want to retain the shortcut keys)